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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the 

operation of semiconductor products and application examples. You are fully responsible for the incorporation of these 
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for 
any losses incurred by you or third parties arising from the use of these circuits, software, or information. 

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas 
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever 
for any damages incurred by you resulting from errors in or omissions from the information included herein. 

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property 
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in 
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other 
intellectual property rights of Renesas Electronics or others. 

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or 
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such 
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product. 

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High 
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, 
as indicated below. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio 
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial 
robots etc. 
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster 
systems; anticrime systems; and safety equipment etc. 

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a 
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may 
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality 
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas 
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable 
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for 
which the product is not intended by Renesas Electronics. 

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas 
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage 
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no 
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified 
ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products 
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use 
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to 
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire 
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including 
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or 
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please 
evaluate the safety of the final products or systems manufactured by you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all 
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, 
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your 
noncompliance with applicable laws and regulations. 

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose 
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not 
use Renesas Electronics products or technology described in this document for any purpose relating to military 
applications or use by the military, including but not limited to the development of weapons of mass destruction. When 
exporting the Renesas Electronics products or technology described in this document, you should comply with the 
applicable export control laws and regulations and follow the procedures required by such laws and regulations. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or 
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set 
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as 
a result of unauthorized use of Renesas Electronics products. 

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of 
Renesas Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its 
majority owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4) 



 

 
 

Disclaimer 
 
By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms: 
 

The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is 
assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether 
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular 
purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly 
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data, 
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall 
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other 
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+, 
even if Renesas or its affiliates have been advised of the possibility of such damages.  

 
 
 
Precautions 
 
The following precautions should be observed when operating any RSK+ product: 
 

 

This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and 
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use 
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection 
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.  
 
The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment causes harmful interference to radio or television reception, which can be determined by turning the 
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;  

 

• ensure attached cables do not lie across the equipment  
• reorient the receiving antenna  
• increase the distance between the equipment and the receiver  
• connect the equipment into an outlet on a circuit different from that which the receiver is connected  
• power down the equipment when not in use  
• consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever 

possible shielded interface cables are used.  
 
The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the 
following measures be undertaken;  
 

• The user is advised that mobile phones should not be used within 10m of the product when in use.  
• The user is advised to take ESD precautions when handling the equipment.  

 
The Renesas Starter Kit+ does not represent an ideal reference design for an end product and does not fulfil the 
regulatory standards for an end product. 



 

 
 

How to Use This Manual 

1.    Purpose and Target Readers 
 
This manual is designed to provide the user with an understanding of how to use Application Leading Tool 
(Code Generator) for RX together with the e2 studio IDE to create a working project for the RSK+ platform. It is 
intended for users designing sample code on the RSK+ platform, using the many different incorporated 
peripheral devices. 
 
The manual comprises of step-by-step instructions to generate code and import it into e2 studio, but does not 
intend to be a complete guide to software development on the RSK+ platform. Further details regarding 
operating the RX65N microcontroller may be found in the Hardware Manual and within the provided sample 
code. 
 
Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body 
of the text, at the end of each section, and in the Usage Notes section. 

 
 
The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of 
the manual for details. 

 
The following documents apply to the RX65N Group. Make sure to refer to the latest versions of these 
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web 
site. 
 
Document Type Description Document Title Document No. 
User’s Manual Describes the technical details of the 

RSK+ hardware.  
RSK+RX65N User’s Manual R20UT3558EG 

Tutorial Manual Provides a guide to setting up RSK+ 
environment, running sample code and 
debugging programs. 

RSK+RX65N Tutorial Manual R20UT3562EG 

Quick Start 
Guide 

Provides simple instructions to setup the 
RSK+ and run the first sample. 

RSK+RX65N Quick Start 
Guide 

R20UT3563EG 

Code Generator 
Tutorial 

Provides a guide to code generation and 
importing into the e2 studio IDE. 

RSK+RX65N Code 
Generator Tutorial Manual 

R20UT3564EG 

Schematics Full detail circuit schematics of the RSK+. RSK+RX65N Schematics R20UT3557EG 

Hardware 
Manual 

Provides technical details of the RX65N 
microcontroller. 

RX65N Group, RX651 Group 
Hardware Manual 

R01UH0590EJ 

 
 
 
 
 
 
 
  



 

 
 

2.    List of Abbreviations and Acronyms  
 

Abbreviation Full Form 

ADC Analog-to-Digital Converter 
API Application Programming Interface 

bps bits per second 

CMT Compare Match Timer 

COM COMmunications port referring to PC serial port 
CPU Central Processing Unit 
DVD Digital Versatile Disc 
E1 / E2 Lite Renesas On-chip Debugging Emulator 
GUI Graphical User Interface 
IDE Integrated Development Environment 
IRQ Interrupt Request 
LCD Liquid Crystal Display 
LED Light Emitting Diode 
LSB Least Significant Bit 
LVD Low Voltage Detect 
MCU Micro-controller Unit 
MSB Most Significant Bit 
PC Personal Computer 
PLL Phase-locked Loop 

Pmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc. 
Digilent-Pmod_Interface_Specification 

PSU Power Supply Unit 
RAM Random Access Memory 
ROM Read Only Memory 
RSK+ Renesas Starter Kit+ 
RTC Realtime Clock 
SAU Serial Array Unit 
SCI Serial Communications Interface 
SPI Serial Peripheral Interface 
TAU Timer Array Unit 
TFT Thin Film Transistor 
TPU Timer Pulse Unit 
UART Universal Asynchronous Receiver/Transmitter 
USB Universal Serial Bus 
WDT Watchdog Timer 

All trademarks and registered trademarks are the property of their respective owners. 
 

http://www.digilentinc.com/index.cfm
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1.   Overview 

1.1 Purpose 
 
This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to use the e2 studio 
IDE code generator plug in to create a working project for the RSK+ platform. 
 

1.2 Features 
 
This RSK provides an evaluation of the following features: 
• Project Creation with e2 studio. 
• Code Generation using the code generator plug in. 
• User circuitry such as switches, LEDs and a potentiometer. 
 
The RSK+ board contains all the circuitry required for microcontroller operation. 



RSK+RX65N  2. Introduction 

R20UT3564EG0100 Rev. 1.00  Page 8 of 57 
Jun 30, 2016  

2.   Introduction 

This manual is designed to answer, in tutorial form, how to use the code generator plug in for the RX family 
together with the e2 studio IDE to create a working project for the RSK+ platform. The tutorials help explain the 
following: 
• Project generation using the e2 studio 
• Detailed use of the code generator plug in for e2 studio 
• Integration with custom code 
• Building the project e2 studio 

  
The project generator will create a tutorial project with two selectable build configurations: 
•  ‘HardwareDebug’ is a project built with the debugger support included. Optimisation is set to zero. 
• ‘Release’ is a project with optimised compile options (level two) and no outputs debugging information 

options selected, producing code suitable for release in a product. 
 
These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to 
the e2 studio debugger, compiler toolchains or the E2 Lite emulator. Please refer to the relevant user manuals for more 
in-depth information. 
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3.   Project Creation with e2 studio 

3.1 Introduction 
 
In this section the user will be guided through the steps required to create a new C project for the RX65N 
MCU, ready to generate peripheral driver code using Code Generator.  This project generation step is 
necessary to create the MCU-specific source, project and debug files. 

3.2 Creating the Project 
 
 
• Start e2 studio and select a suitable 

location for the project workspace. 
 

 
 

• In the Welcome page, click ‘Go to 
the e2 studio workbench’. 

 

 

 
 

• Create a new C project by right-
clicking in the Project Explorer 
pane and selecting ‘New -> C 
Project’ as shown.  Alternatively, 
use the menu item ‘File -> New -> 
C Project’. 
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• Enter the project name 
‘CG_Tutorial’. In ‘Project type:’ 
choose ‘Sample Project’. In 
‘Toolchains’ choose ‘Renesas RXC 
Toolchain’. Click ‘Next’. 

 

  
 

• In the ‘Target Specific Settings’ 
dialog, select the options as shown 
in the screenshot opposite. 

• The R5F565N9AxFB  MCU is 
found under RX600 -> RX65N ->  
RX65N - 144 pin. 

• Click ‘Next’. 
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• In the ‘Select Coding Assistant Tool’ 
dialog, select ‘Peripheral Code 
Generator or Firmware Integration 
Technology (FIT)’ then ensure the 
‘Use Peripheral code Generator’ is 
checked. 

• Click ‘Next’. 

 
 

• In ‘Select Additional CPU Options’ 
leave everything at default values. 

• Click ‘Next’. 
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• In the ‘Global Options Settings’ 
leave everything at default values. 

• Click ‘Next’. 
 

  
 

• In the ‘Standard Header Files’ 
dialog, select C99 for ‘Library 
Configuration’.  Untick ‘new(EC++)’ 
and leave all others at defaults. 

• Click ‘Next’. 
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• In the next dialog, untick all check 
boxes except ‘I/O Register 
Definition Files’ as shown opposite.  
Click ‘Finish’. 

 

 
 

• A summary dialog will appear, click 
‘OK’ to complete the project 
generation. 
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4.   Code Generation Using the e2 studio plug in 

4.1 Introduction 
 
Code Generator is an e2 studio plug in GUI tool for generating template ‘C’ source code for the RX65N.  When 
using Code Generator, the user is able to configure various MCU features and operating parameters using 
intuitive GUI controls, thereby bypassing the need in most cases to refer to sections of the Hardware Manual. 
 
Once the user has configured the project, the ‘Generate Code’ function is used to generate three code 
modules for each specific MCU feature selected.  These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’, 
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.  
Within these code modules, the user is then free to add custom code to meet their specific requirement.  
Custom code should be added, whenever possible, in between the following comment delimiters: 
 
/* Start user code for adding. Do not edit comment generated here */ 
/* End user code. Do not edit comment generated here */ 
 
Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on 
subsequent code generation operations.  This is useful if, after adding custom code, the user needs to re-visit 
Code Generator to change any MCU operating parameters. 
 
By following the steps detailed in this Tutorial, the user will generate an e2 studio project called CG_Tutorial.  
The fully completed Tutorial project is contained on the RSK Web Installer 
(https://www.renesas.com/rskrx65n/install) and may be imported into e2 studio by following the steps in the 
Quick Start Guide.  This Tutorial is intended as a learning exercise for users who wish to use the Code 
Generator to generate their own custom projects for e2 studio. 
 
The CG_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT), 
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the 
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK+. 
 
Following a tour of the key user interface features of Code Generator in §4.2, the reader is guided through 
each of the peripheral function configuration dialogs in §4.3.  In §5, the reader is familiarised with the structure 
of the template code, as well as how to add their own code to the user code areas provided by the code 
generator. 
 
The Code Generator installer is contained on the RSK Web Installer.  This installer must be run before 
proceeding to the next section. 

4.2 Code Generator Tour 
 
In this section a brief tour of Code Generator is presented.  For further details of the Code Generator 
paradigm and reference, refer to the Application Leading Tool Common Operations manual. 
You can download the latest document from: https://www.renesas.com/applilet 
Application Leading Tool is the stand-alone version of Code Generator and this manual is applicable to the 
Code Generator. 
 
From the e2 studio menus, select ‘Window -> Perspective -> Open Perspective -> Other.  In the ‘Open 
Perspective’ dialog shown in Figure 4-1, select ‘Code Generator’ and click ‘OK’. 
 

https://www.renesas.com/rskrx65n/install
https://www.renesas.com/applilet
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Figure 4-1  Open Perspective Dialog 

 
In the Project Explorer pane, expand the ‘Code Generator’ and ‘Peripheral Functions’ node.  The Code 
Generator initial view is displayed as illustrated in Figure 4-2. 
 

 
Figure 4-2  Initial View 

 
Code Generator provides GUI features for configuration of MCU sub systems.  Once the user has configured 
all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button, resulting in a 
fully configured e2 studio project that builds and runs without error. 
 
Navigation to the MCU peripheral configuration screens may be performed by double-clicking the required 
function in the Code Generator -> Peripheral Function on the left. 
 
It is also possible to see a preview of the code that will be generated for the current peripheral function 
settings by double-clicking the required function in the Code Generator -> Code Preview on the left. 
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4.3 Code Generation 
 
In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project 
containing interrupts for switch inputs, timers, ADC and a SCI. 
 

4.3.1 Clock Generator 
 
Figure 4-3 shows a screenshot of Code Generator with the Clock Generator function open.  Click on the 
‘Clock setting’ sub tab.  Configure the system clocks as shown in the figure.  In this tutorial we are using the 
on board 24 MHz crystal resonator for our main clock oscillation source and the PLL circuit is in operation.  
The PLL output is used as the main system clock and the divisors should be set as shown in Figure 4-3. 
 

 
Figure 4-3  Clock setting tab 

 



RSK+RX65N  4. Code Generation Using the e2 studio plug in 

R20UT3564EG0100 Rev. 1.00  Page 17 of 57 
Jun 30, 2016  

Click the arrow next to the Generate Report icon. Select ‘Interrupt Controller Unit’ as shown in Figure 4-4 
below.  Proceed to the next section on the Interrupt Controller Unit. 
 

 
Figure 4-4  Select Interrupt Controller Unit 
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4.3.2 Interrupt Controller Unit 
 
Referring to the RSK+ schematic, SW1 is connected to IRQ8 (P00) and SW2 is connected to IRQ9 (P01).  
SW3 is connected directly to the ADTRG0n and will be configured later in §4.3.4.  Navigate to the ‘Interrupt 
Controller Unit’ node in Code Generator and in the ‘General’ tab, configure these two interrupts as falling edge 
triggered as shown in Figure 4-5 below. 
 

 
Figure 4-5  Interrupt Functions tab 
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Navigate to the ‘Group Interrupts’ sub tab and ensure that the ‘Group BL0’ interrupt is selected as shown in 
Figure 4-6.  The Group BL0 interrupt is used for SCI Transmit End Interrupts (TEI) and Reception Error 
Interrupts (ERI) as described in §4.3.5. 
 

 
Figure 4-6  Group Interrupt Functions tab 

 
Click the arrow next to the Generate Report icon. Select ‘Compare Match Timer’ as shown in Figure 4-7 
below.  Proceed to the next section on the Compare Match Timer. 

 
Figure 4-7  Select Compare Match Timer 
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4.3.3 Compare Match Timer 
 
Navigate to the ‘Compare Match Timer’ node in Code Generator.  CMT0 will be used as an interval timer for 
generation of accurate delays.  CMT1 and CMT2 will be used as timers in de-bouncing of switch interrupts.  
 
In the ‘CMT0’ sub-tab configures CMT0 as shown in Figure 4-8.  This timer is configured to generate a high 
priority interrupt every 1ms.  We will use this interrupt later in the tutorial to provide an API for generating high 
accuracy delays required in our application. 
 

 
Figure 4-8  CMT0 tab 

 
Navigate to the ‘CMT1’ sub-tab and configure CMT1 as shown in Figure 4-9.  This timer is configured to 
generate a high priority interrupt after 20ms.  This timer is used as hour short switch de-bounce timer later in 
this tutorial. 
 

 
Figure 4-9  CMT1 tab 
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Navigate to the ‘CMT2’ sub-tab and configure CMT2 as shown in Figure 4-10.  This timer is configured to 
generate a high priority interrupt after 200ms.  This timer is used as our long switch de-bounce timer later in 
this tutorial. 
 

 
Figure 4-10  CMT2 tab 

 
Click the arrow next to the Generate Report icon. Select ‘12-Bit A/D Converter’ as shown in Figure 4-11 below.  
Proceed to the next section on the 12-Bit A/D Converter. 

 
Figure 4-11  Select 12-Bit A/D Converter 
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4.3.4 12-Bit A/D Converter 
 
Navigate to the ‘12-Bit A/D Converter’ node in Code Generator.  In the ‘S12AD0’ sub-tab configures S12AD0 
as shown in Figure 4-12, Figure 4-13 and configure the S12AD0 as shown.  We will be using the S12AD0 in 
Single scan mode on the AN000 input, which is connected to the RV1 potentiometer output on the RSK+.  The 
conversion start trigger will be via the pin connected to SW3. 
 

 
Figure 4-12  S12AD0 tab (1) 
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Figure 4-13  S12AD0 tab (2) 
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Click the arrow next to the Generate Report icon. Select ‘Serial Communications Interface’ as shown in Figure 
4-14 below.  Proceed to the next section on the Serial Communications Interface. 

 
Figure 4-14  Select Serial Communications Interface 
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4.3.5 Serial Communications Interface 
 
Navigate to the ‘Serial Communications Interface’ tab in Code Generator, select the SCI7 sub-tab and apply 
the settings shown in Figure 4-15.  In the RSK+RX65N SCI7 is used as an SPI master for the Pmod LCD on 
the PMOD1 connector as shown in the schematic. 
 

 
Figure 4-15  SCI7 General Setting tab 

 
Select the SCI7 ‘Setting’ sub-tab and configure the SPI Master as illustrated in Figure 4-16.  Make sure the 
‘Transfer direction setting’ is set to ‘MSB-first’ and the ‘Bit rate’ is set to15000000. All other settings remain at 
their defaults. 
 

 
Figure 4-16  SCI7 SPI Master Setting 
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Staying in the ‘Serial Communications Interface’ tab in Code Generator, select the SCI2 sub-tab and apply the 
settings shown in Figure 4-17.  In the RSK+RX65N SCI2 is connected via a Renesas RL78/G1C to provide a 
USB virtual COM port as shown in the schematic. 

 
Figure 4-17  SCI2 General Setting tab 

 
Select the SCI2 ‘Setting’ sub-tab and configure SCI2 as illustrated in Figure 4-18.  Make sure the ‘Start bit 
edge detection’ is set as ‘Falling edge on RXD2 pin’ and the ‘Bit rate’ is set to 19200 bps.  All other settings 
remain at their defaults. 

 
Figure 4-18  SCI2 Asynchronous Setting 
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Click the arrow next to the Generate Report icon. Select ‘I/O Ports’ as shown in Figure 4-19 below.  Proceed 
to the next section on the I/O Ports. 

 
Figure 4-19  Select I/O Ports 

 

4.3.6 I/O Ports 
 
Referring to the RSK+ schematic, LED0 is connected to P03, LED1 is connected to P05, LED2 is connected 
to P73 and LED3 is connected to PJ5.  Navigate to the ‘I/O Ports’ tab in Code Generator and configure these 
four I/O lines as shown in Figure 4-20, Figure 4-21 and Figure 4-22 below.  Ensure that the ‘Output 1’ tick 
box is checked.  This ensures that the code is generated to set LEDs initially off. 
 

 
Figure 4-20  I/O ports – Port0 
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Figure 4-21  I/O ports – Port7 

 

 
Figure 4-22  I/O ports – PortJ 

 
P02 is used as one of the LCD control lines, together with P55, P56 and P93.  Configure these lines as shown 
in Figure 4-23, Figure 4-24 and Figure 4-25. 
 

 
Figure 4-23  I/O ports – Port0 
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Figure 4-24  I/O ports – Port5 

 

 
Figure 4-25  I/O ports – Port9 

 
Peripheral function configuration is now complete.  Save the project using the File -> Save, then click 
‘ Generate Code’.  The Console pane should report ‘The operation of generating file was successful’, as 
shown Figure 4-26 below. 
 

 
Figure 4-26  Code generator console 
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4.4 Building the Project 
 
The project template created by Code Generator can now be built.  In the Project Explorer pane expand the 
‘src’ folder.  The four files created by the New Project Wizard in §3.2 have been excluded from the build 
automatically as part of the code generation procedure as shown in Figure 4-27.  This is because the main 
function now resides in r_cg_main.c in the cg_src folder and the type definitions and setting of sections has 
been handled by the Code Generator. 
 

 
 

Figure 4-27  Files excluded from the build by Code Generator 
 

Switch back to the ‘C/C++’ perspective using the  button on the top right of the e2 studio 

workspace.  Use ‘Build Project’ from the ‘Project’ menu or the  button to build the tutorial.  The project 
will build with no errors. 
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5.   User Code Integration 

In this section the remaining application code is added to the project.  Source files found on the RSK Web 
Installer are copied into the workspace and the user is directed to add code in the user areas of the code 
generator files. 
 
Code must be inserted in to the user code area in many files in this project, in the areas delimited by 
comments as follows: 
 
/* Start user code for _xxxxx_. Do not edit comment generated here */ 
/* End user code. Do not edit comment generated here */ 

 
Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and 
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor 
include directives.  User code inserted inside these comment delimiters is protected from being overwritten by 
Code Generator, if the user needs to subsequently change any of the Code Generator-generated code. 
 

5.1 LCD Code Integration 
 
API functions for the Okaya LCD display are provided with the RSK+.  Locate the files ascii.h, r_okaya_lcd.h, 
ascii.c, and r_okaya_lcd.c on the RSK Web Installer.  These files can be found in the Tutorial project for e2 
studio.  Copy these files into the C:\Workspace\CG_Tutorial\src directory.  The files will be automatically 
added to the project as shown in Figure 5-1. 
 

 
Figure 5-1  Adding files to the project 
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In the e2 studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it.  Insert the following #defines in between the user code delimiter comments as shown below. 
 
/* Start user code for function. Do not edit comment generated here */ 
#define TRUE            (1) 
#define FALSE           (0) 
 
/* used to stop warnings being generated in r_cg_intprg.c */ 
extern void r_sci2_transmitend_interrupt(void); 
extern void r_sci2_receiveerror_interrupt(void); 
extern void r_sci7_transmitend_interrupt(void); 
/* End user code. Do not edit comment generated here */ 

 
In the same folder open the file ‘r_cg_main.c’ by double-clicking on it. Insert the following code in between the 
user code delimiter comments as shown below. 
 
/* Start user code for include. Do not edit comment generated here */ 
#include "r_okaya_lcd.h" 
/* End user code. Do not edit comment generated here */ 
 
Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the 
user code area of the ‘main’ function: 
 
 
void main(void) 
{ 
    R_MAIN_UserInit(); 
    /* Start user code. Do not edit comment generated here */ 
 
    /* Initialize the debug LCD */ 
    R_LCD_Init(); 
 
    /* Displays the application name on the debug LCD */ 
    R_LCD_Display(0, (uint8_t *)" RSK+RX65N "); 
    R_LCD_Display(1, (uint8_t *)" Tutorial "); 
    R_LCD_Display(2, (uint8_t *)" Press Any Switch "); 
    while (1U) 
    { 
        ; 
    } 
    /* End user code. Do not edit comment generated here */ 
} 
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5.1.1 SPI Code 
 
The Okaya LCD display is driven by the SPI Master that was configured using Code Generator in §4.3.5. In 
the e2 studio Project Tree, open the file ‘r_cg_sci.h’ by double-clicking on it.  Insert the following code in the 
user code area at the end of the file: 
 
/* Start user code for function. Do not edit comment generated here */ 
MD_STATUS R_SCI7_SPIMasterTransmit(uint8_t * const tx_buf, const uint16_t tx_num); 
/* End user code. Do not edit comment generated here */ 

 
Now, open the r_cg_sci_user.c file and insert the following code in the user area for global: 
 
/* Start user code for global. Do not edit comment generated here */ 
/* Flag used locally to detect transmission complete */ 
static volatile uint8_t sci7_txdone; 
/* End user code. Do not edit comment generated here */ 

 
Insert the following code in the transmit end call-back function for SCI7: 
 
static void r_sci7_callback_transmitend(void) 
{ 
    /* Start user code. Do not edit comment generated here */ 
    sci7_txdone = TRUE; 
    /* End user code. Do not edit comment generated here */ 
} 

 
Now insert the following function in the user code area at the end of the file: 
 
/* Start user code for adding. Do not edit comment generated here */ 
/******************************************************************************* 
* Function Name: R_SCI7_SPIMasterTransmit 
* Description  : This function sends SPI7 data to slave device. 
* Arguments    : tx_buf - 
*                    transfer buffer pointer 
*                tx_num - 
*                    buffer size 
* Return Value : status - 
*                    MD_OK or MD_ARGERROR 
*******************************************************************************/ 
MD_STATUS R_SCI7_SPIMasterTransmit (uint8_t * const tx_buf, 
                                      const uint16_t tx_num) 
{ 
    MD_STATUS status = MD_OK; 
     
    /* clear the flag before initiating a new transmission */ 
    sci7_txdone = FALSE; 
 
    /* Send the data using the API */ 
    status = R_SCI7_SPI_Master_Send(tx_buf, tx_num); 
 
    /* Wait for the transmit end flag */ 
    while (FALSE == sci7_txdone) 
    { 
        /* Wait */ 
    } 
 
    return (status); 
} 
 
/******************************************************************************* 
* End of function R_SCI7_SPIMasterTransmit 
*******************************************************************************/ 

This function uses the transmit end callback function to perform flow control on the SPI transmission to the 
LCD, and is used as the main API call in the LCD code module. 
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5.1.2 CMT Code 
 
The LCD code needs to insert delays to meet the timing requirements of the display module.  This is achieved 
using the dedicated timer which was configured using Code Generator in §4.3.3.  Open the file r_cg_cmt.h 
and insert the following code in the user area for function at the end of the file: 
 
/* Start user code for function. Do not edit comment generated here */ 
void R_CMT_MsDelay(const uint16_t millisec); 
/* End user code. Do not edit comment generated here */ 
 

Open the file r_cg_cmt_user.c and insert the following code in the user area for global at the beginning of the 
file: 
 
/* Start user code for global. Do not edit comment generated here */ 
static volatile uint8_t one_ms_delay_complete = FALSE; 
/* End user code. Do not edit comment generated here */ 

 
Scroll down to the r_cmt_cmi0_interrupt function and insert the following line in the user code area: 
 
static void r_cmt_cmi0_interrupt(void) 
{ 
    /* Start user code. Do not edit comment generated here */ 
    one_ms_delay_complete = TRUE; 
    /* End user code. Do not edit comment generated here */ 
} 

 
Then insert the following function in the user code area at the end of the file: 
 
/* Start user code for adding. Do not edit comment generated here */ 
/******************************************************************************* 
* Function Name: R_CMT_MsDelay 
* Description  : Uses CMT0 to wait for a specified number of milliseconds 
* Arguments    : uint16_t millisecs, number of milliseconds to wait 
* Return Value : None 
*******************************************************************************/ 
void R_CMT_MsDelay (const uint16_t millisec) 
{ 
    uint16_t ms_count = 0; 
 
    do 
    { 
        R_CMT0_Start(); 
        while (FALSE == one_ms_delay_complete) 
        { 
            /* Wait */ 
        } 
        R_CMT0_Stop(); 
        one_ms_delay_complete = FALSE; 
        ms_count++; 
    } while (ms_count < millisec); 
 
 
} 
/******************************************************************************* 
End of function R_CMT_MsDelay 
*******************************************************************************/ 
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5.2 Additional include paths 
 
Before the project can be built the compiler needs some additional include paths added.  Select the 
CG_Tutorial project in the Project Explorer pane.  Use the  button in the toolbar to open the project settings.  

Navigate to ‘C/C++ Build -> Settings ->Compiler -> Source and click the  button as shown in Figure 5-2. 
 

 
 

Figure 5-2  Adding additional search paths 
 
In the ‘Add directory path’ dialog, click the ‘Workspace’ button and in the ‘Folder selection’ dialog browse to the 
‘CG_Tutorial/src’ folder and click ‘OK’.  e2 studio formats the path as show in Figure 5-3 below. 
 

 
 

Figure 5-3  Adding workspace search path 
 
Repeat the above steps to add the ‘src/cg_src’ workspace search path.  Select ‘Build Project’ from the ‘Project’ 

menu, or use the  button.  e2 studio will build the project with no errors. 
 
The project may now be run using the debugger as described in §6.  The program will display ‘RSK+RX65N 
Tutorial Press Any Switch’ on 3 lines in the LCD display. 
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5.3 Switch Code Integration 
 
API functions for user switch control are provided with the RSK+.  Locate the files rskrx65ndef.h, 
r_rsk_switch.h and r_rsk_switch.c on the RSK Web Installer.  These files can be found in the Tutorial project 
for e2 studio.  Copy these files into the C:\Workspace\CG_Tutorial\src directory. Import these three files into 
the project in the same way as the LCD files. 
 
The switch code uses interrupt code in the files r_cg_icu.h, r_cg_icu.c and r_cg_icu_user.c and timer code in 
the files r_cg_cmt.h, r_cg_cmt.c and r_cg_cmt_user.c, as described in §4.3.2 and §4.3.3.  It is necessary to 
provide additional user code in these files to implement the switch press/release detection and de-bouncing 
required by the API functions in r_rsk_switch.c. 

5.3.1 Interrupt Code 
 
In the e2 studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_icu.h’ by double-clicking on 
it.  Insert the following code in the user code area at the end of the file: 
 
/* Start user code for function. Do not edit comment generated here */ 
/* Function prototypes for detecting and setting the edge trigger of ICU_IRQ */ 
uint8_t R_ICU_IRQIsFallingEdge(const uint8_t irq_no); 
void R_ICU_IRQSetFallingEdge(const uint8_t irq_no, const uint8_t set_f_edge); 
void R_ICU_IRQSetRisingEdge(const uint8_t irq_no, const uint8_t set_r_edge); 
/* End user code. Do not edit comment generated here */ 
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Now, open the r_cg_icu.c file and insert the following code in the user code area at the end of the file: 
 
/* Start user code for adding. Do not edit comment generated here */ 
 
/******************************************************************************* 
* Function Name: R_ICU_IRQIsFallingEdge 
* Description  : This function returns 1 if the specified ICU_IRQ is set to 
*                falling edge triggered, otherwise 0. 
* Arguments    : uint8_t irq_no 
* Return Value : 1 if falling edge triggered, 0 if not 
*******************************************************************************/ 
uint8_t R_ICU_IRQIsFallingEdge (const uint8_t irq_no) 
{ 
    uint8_t falling_edge_trig = 0x0; 
 

    if (ICU.IRQCR[irq_no].BYTE & _04_ICU_IRQ_EDGE_FALLING) 
    { 
        falling_edge_trig = 1; 
    } 
 
    return (falling_edge_trig); 
 
} 
 

/******************************************************************************* 
* End of function R_ICU_IRQIsFallingEdge 
*******************************************************************************/ 
 

/******************************************************************************* 
* Function Name: R_ICU_IRQSetFallingEdge 
* Description  : This function sets/clears the falling edge trigger for the 
*                specified ICU_IRQ. 
* Arguments    : uint8_t irq_no 
*                uint8_t set_f_edge, 1 if setting falling edge triggered, 0 if 
*                clearing 
* Return Value : None 
*******************************************************************************/ 
void R_ICU_IRQSetFallingEdge (const uint8_t irq_no, const uint8_t set_f_edge) 
{ 
    if (1 == set_f_edge) 
    { 
        ICU.IRQCR[irq_no].BYTE |= _04_ICU_IRQ_EDGE_FALLING; 
    } 
    else 
    { 
        ICU.IRQCR[irq_no].BYTE &= (uint8_t) ~_04_ICU_IRQ_EDGE_FALLING; 
    } 
} 
 

/****************************************************************************** 
* End of function R_ICU_IRQSetFallingEdge 
*******************************************************************************/ 
 

/******************************************************************************* 
* Function Name: R_ICU_IRQSetRisingEdge 
* Description  : This function sets/clear the rising edge trigger for the 
*                specified ICU_IRQ. 
* Arguments    : uint8_t irq_no 
*                uint8_t set_r_edge, 1 if setting rising edge triggered, 0 if 
*                clearing 
* Return Value : None 
*******************************************************************************/ 
void R_ICU_IRQSetRisingEdge (const uint8_t irq_no, const uint8_t set_r_edge) 
{ 
    if (1 == set_r_edge) 
    { 
        ICU.IRQCR[irq_no].BYTE |= _08_ICU_IRQ_EDGE_RISING; 
    } 
    else 
    { 
        ICU.IRQCR[irq_no].BYTE &= (uint8_t) ~_08_ICU_IRQ_EDGE_RISING; 
    } 
} 
 
/****************************************************************************** 
* End of function R_ICU_IRQSetRisingEdge 
*******************************************************************************/ 
 

/* End user code. Do not edit comment generated here */ 
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Open the r_cg_icu_user.c file and insert the following code in the user code area for include near the top of 
the file: 
 
/* Start user code for include. Do not edit comment generated here */ 
 
/* Defines switch callback functions required by interrupt handlers */ 
#include "r_rsk_switch.h" 
 
/* End user code. Do not edit comment generated here */ 
 

In the same file insert the following code in the user code area inside the function r_icu_irq8_interrupt: 
 
    /* Start user code. Do not edit comment generated here */ 
 
    /* Switch 1 callback handler */ 
    R_SWITCH_IsrCallback1(); 
 
    /* End user code. Do not edit comment generated here */ 

 
In the same file insert the following code in the user code area inside the function r_icu_irq9_interrupt: 
 
    /* Start user code. Do not edit comment generated here */ 
 
    /* Switch 2 callback handler */ 
    R_SWITCH_IsrCallback2(); 
 
    /* End user code. Do not edit comment generated here */ 
 

5.3.2 De-bounce Timer Code 
 
Open the r_cg_cmt_user.c file and insert the following code in the user code area for include near the top of 
the file: 
 
/* Start user code for include. Do not edit comment generated here */ 
 
/* Defines switch callback functions required by interrupt handlers */ 
#include "r_rsk_switch.h" 
 
/* End user code. Do not edit comment generated here */ 

 
In the same file insert the following code in the user code area inside the function r_cmt_cmi1_interrupt: 
 
    /* Start user code. Do not edit comment generated here */ 
 
    /* Stop this timer - we start it again in the de-bounce routines */ 
    R_CMT1_Stop(); 
 
    /* Call the de-bounce call back routine */ 
    R_SWITCH_DebounceIsrCallback(); 
 
    /* End user code. Do not edit comment generated here */ 

 
In the same file insert the following code in the user code area inside the function r_cmt_cmi2_interrupt: 
 
    /* Start user code. Do not edit comment generated here */ 
 
    /* Stop this timer - we start it again in the de-bounce routines */ 
    R_CMT2_Stop(); 
 
    /* Call the de-bounce call back routine */ 
    R_SWITCH_DebounceIsrCallback(); 
 
    /* End user code. Do not edit comment generated here */ 
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5.3.3 Main Switch and ADC Code  
 
In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display 
the result on the LCD.  In §4.3.4 we configured the ADC to be triggered from the ADTRG0# pin, SW3.  In this 
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by 
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected. 
 
In the e2 studio Project Tree open the file ‘r_cg_userdefine.h’.  Insert the following code the user code area, 
resulting in the code shown below 
 
/* Start user code for function. Do not edit comment generated here */ 
#define TRUE            (1) 
#define FALSE           (0) 
 

extern volatile uint8_t g_adc_trigger; 
/* used to stop warnings being generated in r_cg_intprg.c */ 
extern void r_sci2_transmitend_interrupt(void); 
extern void r_sci2_receiveerror_interrupt(void); 
extern void r_sci7_transmitend_interrupt(void); 
/* End user code. Do not edit comment generated here */ 

 
Open the file ‘r_cg_main.c’ and insert #include "r_rsk_switch.h" in the user code area for include, resulting in 
the code shown below: 
 
/* Start user code for include. Do not edit comment generated here */ 
#include "r_okaya_lcd.h" 
#include "r_rsk_switch.h" 
/* End user code. Do not edit comment generated here */ 

 
Next add the switch module initialization function call highlighted in the user code area inside the main 
function, resulting in the code shown below: 
 
void main(void) 
{ 
    R_MAIN_UserInit(); 
    /* Start user code. Do not edit comment generated here */ 
 
    /* Initialize the switch module */ 
    R_SWITCH_Init(); 
 
    /* Initialize the debug LCD */ 
    R_LCD_Init(); 
 

    /* Displays the application name on the debug LCD */ 
    R_LCD_Display(0, (uint8_t *)" RSK+RX65N "); 
    R_LCD_Display(1, (uint8_t *)" Tutorial "); 
    R_LCD_Display(2, (uint8_t *)" Press Any Switch "); 
 
    while (1U) 
    { 
        ; 
    } 
    /* End user code. Do not edit comment generated here */ 
} 
 

In the same file, insert the declarations in the user code area for global, resulting in the code shown below: 
 
/* Start user code for global. Do not edit comment generated here */ 
 
/* Variable for flagging user requested ADC conversion */ 
volatile uint8_t g_adc_trigger = FALSE; 
 
/* Prototype declaration for cb_switch_press */ 
static void cb_switch_press (void); 
 

/* Prototype declaration for get_adc */ 
static uint16_t get_adc(void); 
 
/* Prototype declaration for lcd_display_adc */ 
static void lcd_display_adc (const uint16_t adc_result); 
 
/* End user code. Do not edit comment generated here */ 
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Next add the highlighted code below in the user code area inside the main function and the code inside the 
while loop, resulting in the code shown below: 
 
void main(void) 
{ 
    R_MAIN_UserInit(); 
    /* Start user code. Do not edit comment generated here */ 
 
    /* Initialize the switch module */ 
    R_SWITCH_Init(); 
 

    /* Set the call back function when SW1 or SW2 is pressed */ 
    R_SWITCH_SetPressCallback(cb_switch_press); 
 
    /* Initialize the debug LCD */ 
    R_LCD_Init (); 
 
    /* Displays the application name on the debug LCD */ 
    R_LCD_Display(0, (uint8_t *)" RSK+RX65N "); 
    R_LCD_Display(1, (uint8_t *)" Tutorial "); 
    R_LCD_Display(2, (uint8_t *)" Press Any Switch "); 
 
    /* Start the A/D converter */ 
    R_S12AD0_Start(); 
 
    while (1U) 
    { 
        uint16_t adc_result; 
 

        /* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */ 
        if (TRUE == g_adc_trigger) 
        { 
            /* Call the function to perform an A/D conversion */ 
            adc_result = get_adc(); 
 
            /* Display the result on the LCD */ 
            lcd_display_adc(adc_result); 
 

            /* Reset the flag */ 
            g_adc_trigger = FALSE; 
        } 
        /* SW3 is directly wired into the ADTRG0n pin so will  
           cause the interrupt to fire */ 
        else if (TRUE == g_adc_complete) 
        { 
            /* Get the result of the A/D conversion */ 
            R_S12AD0_Get_ValueResult(ADCHANNEL0, &adc_result); 
             
            /* Display the result on the LCD */ 
            lcd_display_adc(adc_result); 
 
            /* Reset the flag */ 
            g_adc_complete = FALSE; 
        } 
        else 
        { 
            /* do nothing */ 
        } 
    } 
    /* End user code. Do not edit comment generated here */ 
} 
 

Then add the definition for the switch call-back, get_adc and lcd_display_adc functions in the user code area 
for adding at the end of the file, as shown below: 
 
/* Start user code for adding. Do not edit comment generated here */ 
/****************************************************************************** 
* Function Name : cb_switch_press 
* Description   : Switch press callback function. Sets g_adc_trigger flag. 
* Argument      : none 
* Return value  : none 
******************************************************************************/ 
static void cb_switch_press (void) 
{ 
    /* Check if switch 1 or 2 was pressed */ 
    if (g_switch_flag & (SWITCHPRESS_1 | SWITCHPRESS_2)) 
    { 
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        /* set the flag indicating a user requested A/D conversion is required */ 
        g_adc_trigger = TRUE; 
 
        /* Clear flag */ 
        g_switch_flag = 0x0; 
    } 
} 
/****************************************************************************** 
* End of function cb_switch_press 
******************************************************************************/ 
 
/****************************************************************************** 
* Function Name : get_adc 
* Description   : Reads the ADC result, converts it to a string and displays 
*                 it on the LCD panel. 
* Argument      : none 
* Return value  : uint16_t adc value 
******************************************************************************/ 
static uint16_t get_adc (void) 
{ 
    /* A variable to retrieve the adc result */ 
    uint16_t adc_result; 
 
    /* Stop the A/D converter being triggered from the pin ADTRG0n  */ 
    R_S12AD0_Stop(); 
     
    /* Start a conversion */ 
    R_S12AD0_SWTriggerStart(); 
 
    /* Wait for the A/D conversion to complete */ 
    while (FALSE == g_adc_complete) 
    { 
        /* Wait */ 
    } 
 
    /* Stop conversion */ 
    R_S12AD0_SWTriggerStop(); 
     
    /* Clear ADC flag */ 
    g_adc_complete = FALSE; 
 
    R_S12AD0_Get_ValueResult(ADCHANNEL0, &adc_result); 
 
    /* Set AD conversion start trigger source back to ADTRG0n pin */ 
    R_S12AD0_Start(); 
     
 
    return (adc_result); 
} 
/****************************************************************************** 
* End of function get_adc 
******************************************************************************/ 
 
/****************************************************************************** 
* Function Name : lcd_display_adc 
* Description   : Converts adc result to a string and displays 
*                 it on the LCD panel. 
* Argument      : uint16_t adc result 
* Return value  : none 
******************************************************************************/ 
static void lcd_display_adc (const uint16_t adc_result) 
{ 
    /* Declare a temporary variable */ 
    uint8_t a; 
 
    /* Declare temporary character string */ 
    char    lcd_buffer[11] = " ADC: XXXH"; 
 
    /* Convert ADC result into a character string, and store in the local. 
       Casting to ensure use of correct data type. */ 
    a = (uint8_t)((adc_result & 0x0F00) >> 8); 
    lcd_buffer[6] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37)); 
    a = (uint8_t)((adc_result & 0x00F0) >> 4); 
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    lcd_buffer[7] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37)); 
    a = (uint8_t)(adc_result & 0x000F); 
    lcd_buffer[8] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37)); 
 
    /* Display the contents of the local string lcd_buffer */ 
    R_LCD_Display(3, (uint8_t *)lcd_buffer); 
 
} 
/****************************************************************************** 
* End of function lcd_display_adc 
******************************************************************************/ 

 
 
Open the file ‘r_cg_s12ad.h’ by double-clicking on it.  Insert the following code in the user code area for 
function, resulting in the code shown below: 
 
/* Start user code for function. Do not edit comment generated here */ 
 
/* Flag indicates when A/D conversion is complete */ 
extern volatile uint8_t g_adc_complete; 
 
/* Functions for starting and stopping software triggered A/D conversion */ 
void R_S12AD0_SWTriggerStart(void); 
void R_S12AD0_SWTriggerStop(void); 
 
/* End user code. Do not edit comment generated here */ 
 
Open the file ‘r_cg_s12ad.c’ by double-clicking on it.  Insert the following code in the user code area for 
adding at the end of the file, as shown below: 
 
/* Start user code for adding. Do not edit comment generated here */ 
/******************************************************************************* 
* Function Name: R_S12AD0_SWTriggerStart 
* Description  : This function starts the AD0 converter. 
* Arguments    : None 
* Return Value : None 
*******************************************************************************/ 
void R_S12AD0_SWTriggerStart(void) 
{ 
    IR(PERIB, INTB129) = 0U; 
    IEN(PERIB, INTB129) = 1U; 
    ICU.GENBL1.BIT.EN19 = 1U; 
    S12AD.ADCSR.BIT.ADST = 1U; 
} 
 
/******************************************************************************* 
End of function R_S12AD0_SWTriggerStart 
*******************************************************************************/ 
 
/******************************************************************************* 
* Function Name: R_S12AD0_SWTriggerStop 
* Description  : This function stops the AD0 converter. 
* Arguments    : None 
* Return Value : None 
*******************************************************************************/ 
void R_S12AD0_SWTriggerStop(void) 
{ 
    S12AD.ADCSR.BIT.ADST = 0U; 
    IEN(PERIB, INTB129) = 0U; 
    IR(PERIB, INTB129) = 0U; 
    ICU.GENBL1.BIT.EN19 = 0U; 
} 
 
/******************************************************************************* 
End of function R_S12AD0_SWTriggerStop 
*******************************************************************************/ 
/* End user code. Do not edit comment generated here */ 
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Open the file r_cg_s12ad_user.c and insert the following code in the user code area for global, resulting in the 
code shown below: 
 
/* Start user code for global. Do not edit comment generated here */ 
/* Flag indicates when A/D conversion is complete */ 
volatile uint8_t g_adc_complete; 
/* End user code. Do not edit comment generated here */ 
 
Insert the following code in the user code area of the r_s12ad0_interrupt function, resulting in the code shown 
below: 
 
static void r_s12ad0_interrupt(void) 
{  
    /* Start user code. Do not edit comment generated here */ 
    g_adc_complete = TRUE; 
    /* End user code. Do not edit comment generated here */ 
} 

Select ‘Build Project’ from the ‘Project’ menu, or use the  button.  e2 studio will build the project with no 
errors. 
 
The project may now be run using the debugger as described in §6.  When any switch is pressed, the 
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the 
LCD panel.  Return to this point in the Tutorial to add the UART user code. 
 



RSK+RX65N  5. User Code Integration 

R20UT3564EG0100 Rev. 1.00  Page 44 of 57 
Jun 30, 2016  

5.4 Debug Code Integration 
 
API functions for trace debugging via the RSK serial port are provided with the RSK+.  Locate the files 
r_rsk_debug.h and r_rsk_debug.c on the RSK Web Installer.  These files can be found in the 
RSK+RX65N_Tutorial project for e2 studio.  Copy these files into the C:\Workspace\CG_Tutorial\src directory. 
Import these two files into the project in the same way as the LCD files. 
 
In the r_rsk_debug.h file, ensure the following macro definition is included: 
 
/* Macro for definition of serial debug transmit function - user edits this */ 
#define SERIAL_DEBUG_WRITE (R_SCI2_AsyncTransmit) 

 
This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different 
debug interface is used. 

5.5 UART Code Integration 
5.5.1 SCI Code 
 
In the e2 studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_sci.h’ by double-clicking on 
it.  Insert the following code in the user code area at the end of the file: 
 
/* Start user code for function. Do not edit comment generated here */ 
 
/* Exported functions used to transmit a number of bytes and wait for completion */ 
MD_STATUS R_SCI7_SPIMasterTransmit(uint8_t * const tx_buf, const uint16_t tx_num); 
MD_STATUS R_SCI2_AsyncTransmit(uint8_t * const tx_buf, const uint16_t tx_num); 
 
/* Character is used to receive key presses from PC terminal */ 
extern uint8_t g_rx_char; 
 
/* Flag used to control transmission to PC terminal */ 
extern volatile uint8_t g_tx_flag; 
 
/* End user code. Do not edit comment generated here */ 
 

Open the file ‘r_cg_sci_user.c.  Insert the following code in the user area for global near the beginning of the 
file: 
 
/* Start user code for global. Do not edit comment generated here */ 
 
/* Global used to receive a character from the PC terminal */ 
uint8_t g_rx_char; 
 
/* Flag used to control transmission to PC terminal */ 
volatile uint8_t g_tx_flag = FALSE; 
 
/* Flag used locally to detect transmission complete */ 
static volatile uint8_t sci7_txdone; 
static volatile uint8_t sci2_txdone; 
 
/* End user code. Do not edit comment generated here */ 
 
In the same file, insert the following code in the user code area inside the r_sci2_callback_transmitend 
function: 
 
static void r_sci2_callback_transmitend(void) 
{ 
    /* Start user code. Do not edit comment generated here */ 
    sci2_txdone = TRUE; 
 
    /* End user code. Do not edit comment generated here */ 
} 
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In the same file, insert the following code in the user code area inside the r_sci2_callback_receiveend 
function: 
 
static void r_sci2_callback_receiveend(void) 
{ 
    /* Start user code. Do not edit comment generated here */ 
    /* Check the contents of g_rx_char */ 
    if (('c' == g_rx_char) || ('C' == g_rx_char)) 
    { 
        g_adc_trigger = TRUE; 
    } 
 
    /* Set up SCI2 receive buffer and callback function again */ 
    R_SCI2_Serial_Receive((uint8_t *)&g_rx_char, 1); 
 
    /* End user code. Do not edit comment generated here */ 
} 

 
At the end of the file, in the user code area for adding, add the following function definition: 
 
/******************************************************************************* 
* Function Name: R_SCI2_AsyncTransmit 
* Description  : This function sends SCI2 data and waits for the transmit end flag. 
* Arguments    : tx_buf - 
*                    transfer buffer pointer 
*                tx_num - 
*                    buffer size 
* Return Value : status - 
*                    MD_OK or MD_ARGERROR 
*******************************************************************************/ 
MD_STATUS R_SCI2_AsyncTransmit (uint8_t * const tx_buf, const uint16_t tx_num) 
{ 
    MD_STATUS status = MD_OK; 
     
    /* clear the flag before initiating a new transmission */ 
    sci2_txdone = FALSE; 
 
    /* Send the data using the API */ 
    status = R_SCI2_Serial_Send(tx_buf, tx_num); 
 
    /* Wait for the transmit end flag */ 
    while (FALSE == sci2_txdone) 
    { 
        /* Wait */ 
    } 
    return (status); 
} 
 
/******************************************************************************* 
* End of function R_SCI2_AsyncTransmit 
*******************************************************************************/ 
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5.5.2 Main UART code 
 
Open the file ‘r_cg_main.c’.  Add the following declaration to the user code area for include near the top of the 
file: 
 
/* Start user code for include. Do not edit comment generated here */ 
#include "r_okaya_lcd.h" 
#include "r_rsk_switch.h" 
#include "r_rsk_debug.h" 
/* End user code. Do not edit comment generated here */ 
 
Add the following declaration to the user code area for global near the top of the file: 
 
/* Start user code for global. Do not edit comment generated here */ 
/* Variable for flagging user requested ADC conversion */ 
volatile uint8_t g_adc_trigger = FALSE; 
 
/* Prototype declaration for cb_switch_press */ 
static void cb_switch_press (void); 
 
/* Prototype declaration for get_adc */ 
static uint16_t get_adc(void); 
 

/* Prototype declaration for lcd_display_adc */ 
static void lcd_display_adc (const uint16_t adc_result); 
 
/* Prototype declaration for uart_display_adc */ 
static void uart_display_adc(const uint8_t adc_count, const uint16_t adc_result); 
 
/* Variable to store the A/D conversion count for user display */ 
static uint8_t adc_count = 0; 
 
/* End user code. Do not edit comment generated here */ 
 

Add the following highlighted code to the user code area in the main function: 
 
void main(void) 
{ 
    R_MAIN_UserInit(); 
    /* Start user code. Do not edit comment generated here */ 
 
    /* Initialize the switch module */ 
    R_SWITCH_Init(); 
 
    /* Set the call back function when SW1 or SW2 is pressed */ 
    R_SWITCH_SetPressCallback(cb_switch_press); 
 

    /* Initialize the debug LCD */ 
    R_LCD_Init(); 
 
    /* Displays the application name on the debug LCD */ 
    R_LCD_Display(0, (uint8_t *)" RSK+RX65N "); 
    R_LCD_Display(1, (uint8_t *)" Tutorial "); 
    R_LCD_Display(2, (uint8_t *)" Press Any Switch "); 
 
    /* Start the A/D converter */ 
    R_S12AD0_Start(); 
 
    /* Set up SCI2 receive buffer and callback function */ 
    R_SCI2_Serial_Receive((uint8_t *)&g_rx_char, 1); 
 
    /* Enable SCI2 operations */ 
    R_SCI2_Start(); 
 

    while (1U) 
    { 
        uint16_t adc_result; 
 
        /* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */ 
        if (TRUE == g_adc_trigger) 
        { 
            /* Call the function to perform an A/D conversion */ 
            adc_result = get_adc(); 
 
            /* Display the result on the LCD */ 
            lcd_display_adc(adc_result); 
 

            /* Increment the adc_count */ 
            if (16 == (++adc_count)) 
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            { 
                adc_count = 0; 
            } 
 

            /* Send the result to the UART */ 
            uart_display_adc(adc_count, adc_result); 
            /* Reset the flag */ 
            g_adc_trigger = FALSE; 
        } 
        /* SW3 is directly wired into the ADTRG0n pin so will  
           cause the interrupt to fire */ 
        else if (TRUE == g_adc_complete) 
        { 
            /* Get the result of the A/D conversion */ 
            R_S12AD0_Get_ValueResult(ADCHANNEL0, &adc_result); 
             
            /* Display the result on the LCD */ 
            lcd_display_adc(adc_result); 
 

            /* Increment the adc_count */ 
            if (16 == (++adc_count)) 
            { 
                adc_count = 0; 
            } 
 
            /* Send the result to the UART */ 
            uart_display_adc(adc_count, adc_result); 
            /* Reset the flag */ 
            g_adc_complete = FALSE; 
        } 
        else 
        { 
            /* do nothing */ 
        } 
    } 
    /* End user code. Do not edit comment generated here */ 
} 

 
Then, add the following function definition in the user code area at the end of the file: 
 
/****************************************************************************** 
* Function Name : uart_display_adc 
* Description   : Converts adc result to a string and sends it to the UART1. 
* Argument      : uint8_t : adc_count 
*                 uint16_t: adc result 
* Return value  : none 
******************************************************************************/ 
static void uart_display_adc (const uint8_t adc_count, const uint16_t adc_result) 
{ 
    /* Declare a temporary variable */ 
    char a; 
 
    /* Declare temporary character string */ 
    static char uart_buffer[] = "ADC xH Value: xxxH\r\n"; 
 
    /* Convert ADC result into a character string, and store in the local. 
       Casting to ensure use of correct data type. */ 
    a = (char)(adc_count & 0x000F); 
    uart_buffer[4] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37)); 
    a = (char)((adc_result & 0x0F00) >> 8); 
    uart_buffer[14] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37)); 
    a = (char)((adc_result & 0x00F0) >> 4); 
    uart_buffer[15] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37)); 
    a = (char)(adc_result & 0x000F); 
    uart_buffer[16] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37)); 
 
    /* Send the string to the UART */ 
    R_DEBUG_Print(uart_buffer); 
 
} 
 
/****************************************************************************** 
* End of function uart_display_adc 
******************************************************************************/ 

 
Select ‘Build Project’ from the ‘Build’ menu.  e2 studio will build the project with no errors. 
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The project may now be run using the debugger as described in §6.  Connect the RSK G1CUSB0 port to a 
USB port on a PC.  If this is the first time the RSK has been connected to the PC then a device driver will be 
installed automatically.  Open Device Manager, the virtual COM port will now appear under 'Port (COM & 
LPT)' as 'RSK USB Serial Port (COMx)', where x is a number. 
 
Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI2 (see §4.3.5).  
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion 
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC 
terminal program via the SCI2.  Return to this point in the Tutorial to add the LED user code. 

5.6 LED Code Integration 
 
Open the file ‘r_cg_main.c’.  Add the following declaration to the user code area for include near the top of the 
file: 
 
/* Start user code for include. Do not edit comment generated here */ 
#include "r_okaya_lcd.h" 
#include "r_rsk_switch.h" 
#include "r_rsk_debug.h" 
#include "rskrx65ndef.h" 
/* End user code. Do not edit comment generated here */ 
 
Add the following declaration to the user code area for global near the top of the file: 
 
/* Start user code for global. Do not edit comment generated here */ 
/* Prototype declaration for cb_switch_press */ 
static void cb_switch_press (void); 
 
/* Prototype declaration for get_adc */ 
static uint16_t get_adc(void); 
 
/* Prototype declaration for lcd_display_adc */ 
static void lcd_display_adc (const uint16_t adc_result); 
 
/* Variable for flagging user requested ADC conversion */ 
volatile uint8_t g_adc_trigger = FALSE; 
/* Prototype declaration for uart_display_adc */ 
static void uart_display_adc(const uint8_t adc_count, const uint16_t adc_result); 
 
/* Variable to store the A/D conversion count for user display */ 
static uint8_t adc_count = 0; 
 
/* Prototype declaration for led_display_count */ 
static void led_display_count(const uint8_t count); 
 
/* End user code. Do not edit comment generated here */ 

 
Add the following highlighted code to the user code area in the main function: 
 
 
void main(void) 
{ 
    R_MAIN_UserInit(); 
    /* Start user code. Do not edit comment generated here */ 
 
    /* Initialize the switch module */ 
    R_SWITCH_Init(); 
 
    /* Set the call back function when SW1 or SW2 is pressed */ 
    R_SWITCH_SetPressCallback(cb_switch_press); 
 
    /* Initialize the debug LCD */ 
    R_LCD_Init(); 
     
    /* Displays the application name on the debug LCD */ 
    R_LCD_Display(0, (uint8_t *)" RSK+RX65N "); 
    R_LCD_Display(1, (uint8_t *)" Tutorial "); 
    R_LCD_Display(2, (uint8_t *)" Press Any Switch "); 
 
    /* Start the A/D converter */ 
    R_S12AD0_Start(); 
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    /* Set up SCI2 receive buffer and callback function */ 
    R_SCI2_Serial_Receive((uint8_t *)&g_rx_char, 1); 
 
    /* Enable SCI2 operations */ 
    R_SCI2_Start(); 
 
    while (1U) 
    { 
        uint16_t adc_result; 
 
        /* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */ 
        if (TRUE == g_adc_trigger) 
        { 
            /* Call the function to perform an A/D conversion */ 
            adc_result = get_adc(); 
 
            /* Display the result on the LCD */ 
            lcd_display_adc(adc_result); 
 
            /* Increment the adc_count and display using the LEDs */ 
            if (16 == (++adc_count)) 
            { 
                adc_count = 0; 
            } 
            led_display_count(adc_count); 
 
            /* Send the result to the UART */ 
            uart_display_adc(adc_count, adc_result); 
            /* Reset the flag */ 
            g_adc_trigger = FALSE; 
        } 
        /* SW3 is directly wired into the ADTRG0n pin so will  
           cause the interrupt to fire */ 
        else if (TRUE == g_adc_complete) 
        { 
            /* Get the result of the A/D conversion */ 
            R_S12AD0_Get_ValueResult(ADCHANNEL0, &adc_result); 
             
            /* Display the result on the LCD */ 
            lcd_display_adc(adc_result); 
 
            /* Increment the adc_count and display using the LEDs */ 
            if (16 == (++adc_count)) 
            { 
                adc_count = 0; 
            } 
            led_display_count(adc_count); 
 
            /* Send the result to the UART */ 
            uart_display_adc(adc_count, adc_result); 
            /* Reset the flag */ 
            g_adc_complete = FALSE; 
        } 
        else 
        { 
            /* do nothing */ 
        } 
    } 
    /* End user code. Do not edit comment generated here */ 
} 
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Then, add the following function definition in the user code area at the end of the file: 
 
/****************************************************************************** 
* Function Name : led_display_count 
* Description   : Converts count to binary and displays on 4 LEDS0-3 
* Argument      : uint8_t count 
* Return value  : none 
******************************************************************************/ 
static void led_display_count (const uint8_t count) 
{ 
    /* Set LEDs according to lower nibble of count parameter */ 
    LED0 = (uint8_t)((count & 0x01) ? LED_ON : LED_OFF); 
    LED1 = (uint8_t)((count & 0x02) ? LED_ON : LED_OFF); 
    LED2 = (uint8_t)((count & 0x04) ? LED_ON : LED_OFF); 
    LED3 = (uint8_t)((count & 0x08) ? LED_ON : LED_OFF); 
} 
/****************************************************************************** 
* End of function led_display_count 
******************************************************************************/ 
/* End user code. Do not edit comment generated here */ 

 
Select ‘Build Project’ from the ‘Build’ menu, or use the  button.  e2 studio will build the project with no 
errors. 
 
The project may now be run using the debugger as described in §6.  The code will perform the same but now 
the LEDs will display the adc_count in binary form. 
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6.   Debugging the Project 

In the Project Explorer pane, ensure that the ‘CG_Tutorial’ project is selected. To enter the debug 
configurations, click upon the arrow next to the debug button and select ‘Debug Configuration’. In order to run 
the project there are two setting under ‘Renesas GDB Hardware Debugging’ -> ‘Debugger’ -> ‘Connection 
Settings’ that need modifying. 
Ensure that in debug configuration that the ‘Power Target From The Emulator(MAX 200mA)’ is set to No , and 
the ‘Extal Frequency’ is set to the correct frequency, this can be found from the device schematics (in the case 
of RSK+RX65N the setting should be 24.0000). 
For more information on powering the RSK+RX65N please refer to the Usermanual. 
 
 

 
Figure 6-1  Debug Configurations 
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Connect the E2 Lite to the PC and the RSK+ E1 connector.  Connect the Pmod LCD to the PMOD1 connector. 
Connect the center positive +5V PSU to the PWR connector on the RSK+ and apply power. 
In the Project Explorer pane, ensure that the ‘CG_Tutorial’ project is selected.  To debug the project, click the 

 button.  The dialog shown in Figure 6-2 will be displayed. 
 

 
Figure 6-2  Perspective Switch Dialog 

 
Click Remember my decision to skip this dialog later. Click ‘YES’ to confirm that the debug window 
perspective will be used.  The debugger will start up and the code will stop at the Code Generator function 
‘PowerOn_Reset_PC’ as shown in Figure 6-3. 
 

 
Figure 6-3  Debugger start up screen 

 
For more information on the e2 studio debugger refer to the Tutorial manual.  To run the code click the  
button.  The debugger will stop again at the beginning of the main function.  Press  again to run the code. 
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7.   Additional Information 

Technical Support 
For details on how to use e2 studio, refer to 
the help file by opening e2 studio, then 
selecting Help > Help Contents from the 
menu bar. 

 

 
For information about the RX65N group microcontroller refer to the RX65N Group, RX651 Group Hardware Manual. 
 
For information about the RX assembly language, refer to the RX Family Software Manual. 
 
Technical Contact Details 
 
Please refer to the contact details listed in section 8 of the “Quick Start Guide”. 
 
General information on Renesas microcontrollers can be found on the Renesas website at: 
https://www.renesas.com/ 
 
 
Trademarks 
All brand or product names used in this manual are trademarks or registered trademarks of their respective 
companies or organisations. 
 
 
Copyright 
This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of 
this document, either in whole or part is prohibited without the written permission of Renesas Electronics 
Europe Limited. 
 
© 2016 Renesas Electronics Europe Limited. All rights reserved. 
© 2016 Renesas Electronics Corporation. All rights reserved. 
© 2016 Renesas System Design Co., Ltd. All rights reserved. 
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